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Reflex2DQuick – Ground Penetrating Radar 
Sensors & Software Pulsekko/Noggin Data Visualization Tutorial 

 
 

1. Launch	the	application	“Reflex2DQuick”	

	
2. In	the	top	left,	press	the	“load”	button	

	
3. Under	the	“files	of	types”	menu	at	the	bottom	of	the	dialog	box,	select	“pulsekko”	

	
4. Navigate	to	your	raw	datafile	with	the	suffix	“DT1”	and	open	it.	

	
	

5. You	should	be	automatically	presented	with	a	dialog	box	–	check	the	box	next	to	“subtract	
mean(dewow)”	then	press	“apply/close”	
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6. Next,	go	to	the	Plot	menu	and	choose	Options	

	
	
	
	
	
	
	
	
	
	

7. On	the	left	side,	check	the	AGC	checkbox	and	enter	“50”	into	the	“window”	box.	Press	
update,	then	close.	
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8. Finally,	use	the	up	and	down	arrows	next	to	“plotscale”	on	the	menu	bar	to	increase	or	

reduce	the	contrast	on	the	image	until	you	can	see	some	structure.	
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ResIPy – Electrical Resistivity Tomography 
AGI Super Sting Data Inversion Tutorial 

 
1. Opening ResIPY/Uploading Data 

● Open ResIPY. 

 

 

 

 

 

 

 

 

 

 

● Change the file format to Sting and click Import Data to find the .stg file you want to 

open. 

 

 

 

 

 

 

 

 

 

● Change Title from “My beautiful survey” to a more suitable name. 
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● Your screen should now look similar to the below image. 

 

 

 

 

 

 

 

 

 

 

 

● At this point, elevation data would typically be uploaded under the Electrodes 

(XYZ/Topo) tab. However, your dataset is from a nearly level surface, so this step will be 

skipped. 

 

 

 

 

 

 

 

2. Pre-Processing Data 

● Click on the Pre-Processing menu tab. 

● Choose Reciprocal Error from the drop-down . 
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● Put 5 in the Threshold box left of the drop-down. 

● Click Apply Filters. 

● Your screen should look similar to the image below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Creating a Mesh 

● Click on the Mesh menu tab. 

● Click on the yellow Triangular Mesh button. 
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● A mesh should be created that looks similar to the image below. 

 

 

 

 

 

 

 

 

 

4. Inverting the Data 

● Click on the Inversion menu tab (Note: You most likely won’t have to mess with the 

Inversion Settings tab). 

● Click on the green Invert button. 

 

 

● The screen will begin to populate with the inversion stats. The program is set to do a 

maximum of 10 iterations, but it usually shouldn’t take more than 3. 
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● Once the inversion is complete, ResIPY will automatically switch to the Results tab with 

the completed inversion such as the picture below. 

 

 

 

 

 

 

 

 

 

 

● You have now finished processing the resistivity data! 

○ It is recommended you keep the data set to Resistivity(log10), check Clip 

Corners, and choose the color scale you prefer from the drop-down bar. 

○ The other features you can play with to see what each one does and ask 

questions. 
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Geogigia – Seismic Refraction Picking/Tomography 
Geometrics Geode Data Inversion Tutorial 

 
Step 1: Insert Geogiga Dongle 

● Insert the Geogiga Dongle into a USB port of the computer. 
Step 2: Opening Geogiga 

● Click on the Windows key in the bottom left corner of the screen. 
● Type in “seismic pro” in the search bar. 
● Click on the “Seismic Pro” app. 
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Step 3: Opening DW Tomo 
● After opening the Seismic Pro App the Geogiga Seismic Pro window will open up. 
● Click on the DW Tomo box to open the Geogiga DW Tomo window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 4: Load in Seismic Data 

● Click on the File tab in the top left corner of the Geogiga DW Tomo window.  
● Click on Import Seismic… (third option from the top). 

●  
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● The Geometry Assignment and File Integration window will open up. 
● Click on the Add… button in the lower left corner of the Geometry Assignment and 

File window. An Add Files to File List window will open. 

 
 
 
 
 
 
 
 
 
 
 
 



University of Wyoming – August 2022 – IGUaNA Workshop 

● Find the file location of your seismic data and highlight all seismic shots that you wish to 
analyze.The seismic files should be .dat files. 

● Once the relevant files are highlighted, click the Open box in the lower right corner of the 
Add Files to File List window. 
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● The Geometry Assignment and File Integration window should be open and showing 
your selected files. Click on the Integrate and Load button in the lower right corner of 
the Geometry Assignment and File Integration window. 

● An Information window will pop up. Click the Okay button. 
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Step 5: Shot Display 
● To change the display of the Trace View (the window displayed on the left), click on the 

Display tab in the top left then click on Trace Display… (first option of the drop down 
menu). 

 
● The Trace Display: Pick View window will open. In the Plot tab of the Trace Display: 

Pick View window, choose the Scale Type  to be Trace RMS, make sure the Positive 
and Negative boxes are check marked, choose colors for both Positive (usually green) 
and Negative (usually blue). Also, adjust the Display Gain to around 20dB. Click on the 
Apply box when finished with adjustments.  
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● Click on the Range tab of the Trace Display: Pick View window. In the Time section, 
change the End to 100 and click the Apply box. This will crop the y-axis of the Trace 
View window. 

● Once done with adjustments, click the Close box in the bottom right corner of the Trace 
Display: Pick View window. 
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● The Geogiga DW Tomo window should now look like the image below. 
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Step 6: Picking First Arrivals 
● Open the Pick Settings window by clicking on the Pick tab in the top right corner of the 

Geogiga DW Tomo window. Click on Settings…, which is the first option. 
 
 
 
 
 
 
 
 
 
 
 
 

● In the Pick Settings window, click the Automatically option. 
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● In the Trace Display window, click on what appears to be the first arrival for one of the 
geophone lines. This will cause red lines to appear on all the geophone lines and for a 
red ray to appear in the graph in the right window.

 
● To edit individual picks for each geophone, first click Manually in the Pick Settings 

window. Then click on the Trace Magnifier, which is below and to the right of the Help 
tab in the upper left corner of the Geogiga DW Tomo window. 
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● Use the Trace Magnifier window to move the red line to the first arrival. You can do this 
either by clicking the red line in the Trace Magnifier window and dragging it into the 
correct position or simply by clicking the Trace Magnifier window at the point of the first 
arrival.  

● To move between geophones, use the arrow keys on the keyboard, click on the red line 
of the geophones on the Trace Display window, or in the trace graph click on the point 
you wish to change. 
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● To change between different shots, use the arrow buttons in the upper left of the 
Geogiga DW Tomo window. 

 
 

 
 
 
 
 

● Picking tips and Tricks 
○ If one of the geophones is noisy or has bad data you can delete that point by 

pressing Ctrl and clicking on the picked red line on the Trace View window for 
that geophone. Make sure you are in Manually in the Pick Settings window or 
all your picks will get messed up! 

○ For the geophone at the shot location the first arrival should always be 0.00ms. 
○ The first arrival will be negative (blue) and to the left of the black line in the Trace 

Magnifier window. 
○ You can use the sliders at the bottom of the Trace Magnifier window to adjust 

the zoom and amplification of the wave in the Trace Magnifier window. 
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Step 7: Adding Topography Data 
● Click on the File tab in the Geogiga DW Tomo window. Then click on Input 

Elevation… 

 
● The Input Elevation window will pop up. Copy and paste the geophone location and 

total elevation change into the Slope Distance, Elevation box. If instead you would like 
to use horizontal distance instead of the geophone location (which is equivalent to the 
slope distance), click on Horizontal Distance in the Measure As area. 
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● Once the topography data is entered, click Apply in the lower right corner of the Input 

Elevation window. Make sure the topography is shown in the graph then close out of the 
Input Elevation window by clicking Close in the lower right corner. 
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Step 8: Starting the Inversion 
● Under the Tomography tab of the Geogiga DW Tomo window, click on the Initial 

Model. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

● Click the Calculate box on the right side of the Initial Model window. 
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● In the Build Initial Velocity window, move the two red dots to where the red lines 
overlap the yellow as much as possible (it doesn’t have to be perfect). 

● Click Apply and then Close to exit out of the Initial Model window. This creates a base 
data set that the inversion is going to use as a starting point. 

 
● In the Initial Model window, make sure that the depth and velocity of the initial model 

make sense. Once satisfied with the initial model, click Apply and then Close in the 
lower right of the Initial Model window. 
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● Click on the Tomography tab in the Geogiga DW Tomo window and select Settings, 
which is the second option in the drop down menu. 

 
● The Tomography Settings window will open. In this window, we will change some of 

the settings before starting the inversions. 

 
● In the Constraints section, adjust the Min Velocity and Max Velocity based on 

estimated geophysical properties of the survey area.  
● Under Smoothing, change Horizontal to a number below 10. Start at 5 or lower and 

decrease as necessary to lower the fitting error. 



University of Wyoming – August 2022 – IGUaNA Workshop 

● In the Iterations section, set the Max Iterations to 10 and click OK to close out of the 
Tomography Settings window. If a Warning window pops up, just click Yes to 
continue. 

 
 
 
 
 
 
 
 

● Under the Tomography tab in the Geogiga DW Tomo, click on Start… (it will be the 
third option in the drop down menu). The window that opens will look exactly like the 
Tomography Settings window except instead of OK in the lower right corner  it says 
Start. 

 
 
 

● Click the Start button to begin the inversion. 
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Step 9: Final Results 

● Once the program has run through all 10 of the iterations, check the Fitting Error 
displayed at the bottom right of the screen under the model. 

 
● It is best to aim for below 2 ms. If it is not below 2 ms, adjust the Tomography Settings 

to decrease the Fitting Error. For example, decreasing the horizontal smoothing or max 
velocity may decrease the Fitting Error. 

● Under the Display tab in the Geogiga DW Tomo window, select Trim Image… in order 
to only show the model that has ray paths. 

● To save your seismic picks, go to the File tab and click on Save Seismic. The picked 
data will be in the same file as the seismic shots. The picks will be a .ttx file. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


